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Introduction

Read this book if you are new to COMSOL Multiphysics®. It provides an 
overview of the COMSOL® environment with examples that show you how to use 
the COMSOL Desktop® user interface and the Model Builder. It also provides a 
quick introduction to creating applications and add-ins using the Application 
Builder as well as a quick introduction to the Model Manager.
If you have not yet installed the software, install it now according to the 
instructions at www.comsol.com/product-download.
In addition to this book, an extensive documentation set is available after 
installation. Tutorials can be found throughout the COMSOL website, including 
in the Learning Center at www.comsol.com/support/learning-center, the Video 
Gallery at www.comsol.com/videos, and the COMSOL Blog at 
www.comsol.com/blogs.
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COMSOL Desktop®

MODEL BUILDER —

The Model Builder window 
with its model tree and the 
associated toolbar buttons 
gives you an overview of the 
model. The modeling process 
can be controlled from 
context-sensitive menus 
accessed by right-clicking a 
node.

MODEL BUILDER 
TOOLBAR

QUICK ACCESS TOOLBAR — Use these 
buttons for access to functionality such as file 
open/save, undo/redo, copy/paste, and delete.

SETTINGS WINDOW —

Click any node in the model 
tree to see its associated 
Settings window displayed next 
to the Model Builder.

APPLICATION BUILDER — 
Click this button to switch to 
the Application Builder and 
start building an application 
based on your model.

MODEL TREE — The model 
tree gives an overview of the 
model and all of the functionality 
and operations needed for 
building and solving a model as 
well as processing the results.

MODEL MANAGER — Click this button to switch to 
the Model Manager for managing different versions of 
your models.
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GRAPHICS WINDOW — The Graphics window presents 
interactive graphics for the Geometry, Mesh, and Results nodes. 
Operations include rotating, panning, zooming, and selecting.

FORMATION WINDOWS — The Information windows will display vital 
odel information during the simulation, such as the solution time, solution 
ogress, mesh statistics, solver logs, and, when available, results tables.

GRAPHICS WINDOW TOOLBAR

 The ribbon tabs have buttons 
wn menus for controlling all 
 modeling process.



The screenshot on the previous pages is what you will see when you first start 
modeling in COMSOL Multiphysics using the Model Builder. The COMSOL 
Desktop® user interface provides a complete and integrated environment for 
physics modeling and simulation as well as application design, providing you with 
the tools necessary to build a user-friendly interface for your models. You can 
customize the desktop to your own needs. The windows can be resized, moved, 
docked, and detached. Any changes you make to the layout will be saved when 
you close the session and available again the next time you open COMSOL 
Multiphysics. As you build your model, additional windows and widgets will be 
added. (See page 28 for an example of a more developed desktop.) Among the 
available windows and user interface components are the following:

Quick Access Toolbar

The Quick Access Toolbar gives access to functionality such as Open, Save, Undo, 
Redo, Copy, Paste, and Delete. You can customize its content from the Customize 
Quick Access Toolbar list (the downward-facing arrow to the right of the toolbar).

Ribbon

The ribbon at the top of the desktop gives access to commands used to complete 
most modeling tasks. The ribbon is only available in the Windows® version of the 
COMSOL Desktop environment and is replaced by menus and toolbars in the 
macOS and Linux® versions. Click the Application Builder button to switch from 
the Model Builder to the Application Builder and start building an application 
based on your model.

Settings Window

This is the main window for entering all of the specifications of the model, 
including the dimensions of the geometry, properties of the materials, boundary 
conditions and initial conditions, and any other information that the solver will 
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need to carry out the simulation. The picture below shows the Settings window for 
the Geometry node.

Plot Windows

These are the windows for graphical output. In addition to the Graphics window, 
Plot windows are used for visualizing results. Several Plot windows can be used to 
show multiple results simultaneously. A special case is the Convergence Plot 
window, an automatically generated Plot window that displays a graphical 
indication of the convergence of the solution process while a model is running.

Information Windows

These are the windows for nongraphical information. They include:
• Messages: Various information about the current COMSOL Multiphysics 

session is displayed in this window.
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• Progress: Progress information from the solver in addition to stop buttons.
• Log: Information from the solver, such as the number of degrees of freedom, 

solution time, and solver iteration data.
• Table: Numerical data in table format as defined in the Results node.
• External Process: Provides a control panel for cluster, cloud, and batch jobs.

Other Windows

The Windows dropdown menu in the Home tab of the ribbon gives you access to 
all COMSOL Desktop windows. On macOS and Linux®, you will find this in the 
Windows menu. In addition to the windows described earlier, you can access the 
following windows:
• Add Physics and Add Multiphysics: Expand the physics interfaces in a model.
• Add Study: Change the type of study.
• Results Templates: Add a predefined plot or evaluation associated with a 

physics interface; only available for certain physics interfaces.
• Add Material from Library and the Material Browser: Access the material 

property libraries.
• Application Libraries: Choose among the collections of MPH files containing 

tutorial models and runnable applications with accompanying documentation.
• Part Libraries: Load one of the predefined parameterized geometry models.
• Add-in Libraries: Load one of the add-ins that provides customized 

functionality.
• Selection List: Show a list of geometry objects, domains, boundaries, edges, 

and points that are currently available for selection.
• Properties and Comments: View model tree node properties, where you can 

also type comments.
• Auxiliary Data: View auxiliary data associated with the model such as 

interpolation files or CAD files.
• Messages: Display information after an operation is performed.
• Table: Display results in table format.
• External Process: Control COMSOL Multiphysics processes running 

separately.
• Comparison Result: Compare the Model Builder and Application Builder 

settings of two MPH files.
• Find and Replace: Enter a search string for finding it in the model’s settings, 

tags, labels, tables, etc.
• Versions: Display model versions stored in a Model Manager database.
10 | 



• Chatbot: Command prompt for communicating with a chatbot.
• Java Shell: Command prompt for running and debugging code interactively.
• Data Viewer: Inspect and change parameters, as well as view Application 

Builder declarations and Java method variables.
• Debug Log: Display debug information for methods.
• Recovery Files: View recovery files.
• Physics Builder Manager: Compile user-defined physics interfaces. This is only 

visible if the Physics Builder has been activated in Preferences.

Progress Bar with Cancel Button

The Progress Bar with a button for canceling the current computation, if any, is 
located in the lower right-hand corner of the COMSOL Desktop interface.

Dynamic Help

The Help window provides context-dependent help texts about windows and 
model tree nodes. If you have the Help window open in your desktop (by typing 
F1, for example), you will get dynamic help (in English only) when you click a tree 
node or a window. From the Help window, you can search for other topics, such 
as menu items.

The Model Builder,  the Application Builder,  and the 
Model Manager

The main components of the COMSOL Desktop environment are the Model 
Builder, the Application Builder, and the Model Manager.

THE MODEL BUILDER

The Model Builder is the tool where you define the model and its components, 
such as how to solve it, the analysis of results, and creating reports. You do that by 
building a model tree. The model tree reflects the underlying data structure — the 
model object — which stores the state of the model including settings for 
geometry, mesh, physics, boundary conditions, studies, solvers, postprocessing, 
and visualizations.

THE APPLICATION BUILDER

The Application Builder allows you to quickly create an application (also called an 
app) with a specialized user interface that is easy to use. An application is typically 
 | 11



based on a model created with the Model Builder. The Application Builder 
provides important tools for creating applications including the Form Editor, the 
Main Window Editor, and the Method Editor. The Form Editor includes 
drag-and-drop capabilities to easily access and include user interface components, 
such as input fields, graphics windows, and buttons. The Main Window Editor lets 
you to add ribbon tabs with buttons and menus as well as organize your layout 
using subwindows. The Method Editor is a programming environment that, for 
example, allows you to modify the model represented by the model object data 
structure. You can also use the Method Editor to add user interface logic and 
auxiliary functionality to an application. The Java® programming language is used 
to write code in the Method Editor, which means that all Java® syntax and Java® 
libraries can be used.
In the Method Editor, program code is stored in methods. A method is another 
name for what is known in other programming languages as a subroutine, 
function, or procedure. Methods can be used to modify the model object data 
structure in the Model Builder and the Application Builder. A method can be used 
both for modifying the model object of the current session and for modifying the 
model object in a running application. For a quick introduction to the Application 
Builder, see “Building an Application with the Application Builder” on page 119.

THE MODEL MANAGER

The Model Manager is a workspace for simulation data management. It allows you 
to collaborate with other users and centrally organize models and apps. The 
Model Manager provides version control to track changes and updates to your 
files. It will aid you in storing only relevant data of MPH file drafts and revisions. 
The Model Manager includes an advanced search tool that allows you to search 
the models and applications stored in a Model Manager database for contents 
based on keywords or tags. Depending on your license type, you can connect to a 
local or remote and centrally managed Model Manager database. For a quick 
introduction to the Model Manager, see “Using the Model Manager” on page 
188.

FURTHER READING

This book, Introduction to COMSOL Multiphysics, gives a detailed introduction 
to using the Model Builder and a quick introduction to the Application Builder 
and the Model Manager. For detailed information on how to use the Application 
Builder, see Introduction to Application Builder and the Application 
Programming Guide. For more information on the Model Manager, see the 
Reference Manual and the Model Manager Manual.
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Applications,  COMSOL Server™,  and COMSOL 
Compiler™

The Application Builder is included in the Windows® version of COMSOL 
Multiphysics. With a COMSOL Multiphysics license, apps can be run from the 
COMSOL Desktop environment. Although applications cannot be built with the 
macOS or Linux® versions of the software, applications can still be run with 
COMSOL Multiphysics on those platforms.
By using COMSOL Compiler™ you can compile your application (MPH file) to 
an executable file for Windows®, Linux®, and macOS. You can freely distribute 
the executable and it can be run without any license file.
With a COMSOL Server™ license, applications can be run in major web browsers 
on a variety of operating systems and hardware platforms. In addition, you can run 
applications by connecting to COMSOL Server with an easy-to-install COMSOL 
Client for Windows®.
The COMSOL Client for Windows® allows a user to run applications that require 
a LiveLink™ product for CAD (this functionality is not available when running 
applications with a web browser).
Running applications in a web browser does not require any installation and no 
web browser plug-ins are needed. Running an application in a web browser 
supports interactive graphics in 1D, 2D, and 3D. In a web browser, graphics 
rendering in 3D is based on WebGL™ technology, which comes with all major 
web browsers.
To create an application based on your model, 
click the Application Builder button, accessible 
from the Home tab in the ribbon.
For more information on creating COMSOL 
applications, refer to the section “Building an 
Application with the Application Builder” on page 
119 and the book Introduction to Application 
Builder.
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Preferences

Preferences are settings that affect the modeling environment. Most are persistent 
between modeling sessions, but some are saved with the model. You access the 
preferences from the File menu by selecting Preferences.

In the Preferences window, you can change settings such as graphics rendering, the 
number of displayed digits for results, the maximum number of CPU cores used 
for computations, or paths to user-defined application libraries. Take a moment to 
browse your current settings to familiarize yourself with the different options.

GRAPHICS AND PLOT WINDOWS

In the Graphics page, there are two graphics rendering options available: OpenGL® 
and Software Rendering. If your computer does not have a dedicated graphics card, 
you may have to switch to Software Rendering for slower but fully functional 
graphics. A list of recommended graphics cards can be found at:

www.comsol.com/system-requirements
14 | 
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COLOR THEMES

In the User Interface > Color Themes page, there are three color theme preferences:
• Desktop color theme: Choose between a Default, Light, or Dark theme for the 

COMSOL Desktop environment.
• Graphics color theme: Choose a color theme for the Graphics window.
• Image export color theme: Choose a color theme for exported images.

When using the Dark theme in Linux®, some controls take their color from the 
operating system’s theme. You will get a better user experience by picking both a 
dark-looking theme in Linux® and the Dark theme in the COMSOL Desktop 
environment.
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Opening and Saving Fi les from the Fi le Menu

The File menu provides several options for opening and saving model files in the 
COMSOL MPH file format, as well as a few other supported formats.

• New lets you create a new model from scratch.
• Run Application opens and runs an application if a runnable application 

definition is available in the chosen MPH file.
• Open opens an existing file 

from the file system using 
the Open dialog.
16 | 



• Open From opens an 
existing file from either 
the file system or from a 
Model Manager database 
(see “Using the Model 
Manager” on page 188).

• Recent opens a recently 
opened file from the file 
system or from a Model 
Manager database.

• Application Libraries opens a tutorial model or a runnable application from the 
Application Libraries.

• Save saves the current file.
• Save As lets you save the 

current file to the file system 
with a new name using the 
Save As dialog.

• Save To lets you save to 
a Model Manager 
database.

• Revert to Saved opens the last saved version of the file and reinitializes the 
user interface.
 | 17



Creating a New Model

You can set up a model guided by the Model Wizard or start from a Blank Model as 
shown in the figure below.

CREATING A MODEL GUIDED BY THE MODEL WIZARD

The Model Wizard will guide you in setting up the space dimension, physics, and 
study type in a few steps:
1 Start by selecting the space dimension for your model component: 3D, 2D 

Axisymmetric, 2D, 1D Axisymmetric, or 0D.

2 Now, add one or more physics interfaces. These are organized in a number of 
physics branches in order to make them easy to locate. These branches do not 
directly correspond to products. When products are added to your COMSOL 
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Multiphysics installation, one or more branches will be populated with 
additional physics interfaces.
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3 Select the Study type that represents the solver or set of solvers that will be used 
for the computation.

Finally, click Done. The desktop is now displayed with the model tree configured 
according to the choices you made in the Model Wizard.

CREATING A BLANK MODEL

The Blank Model option will open the COMSOL Desktop interface without any 
Component or Study. You can right-click the model tree to add a Component of a 
certain space dimension, physics interface, or Study.
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The Ribbon, Quick Access Toolbar,  and Graphics Menus

The ribbon tabs in the COMSOL Desktop environment reflect the modeling 
workflow and give an overview of the functionality available for each modeling 
step, including building simulation applications from your models.

The Home tab contains buttons for the most common operations for making 
changes to a model, running simulations, and for building and testing 
applications. Examples include changing model parameters for a parameterized 
geometry, reviewing material properties and physics, building the mesh, running 
a study, and visualizing the simulation results.
There are standard tabs for each of the main steps in the modeling process. These 
are ordered from left to right according to the workflow: Definitions, Geometry, 
Materials, Physics, Mesh, Study, Results, and Developer.
Contextual tabs are shown only if they are needed, such as the 3D Plot Group tab, 
which is shown when the corresponding plot group is added or when the node is 
selected in the model tree.

Modal tabs are used for very specific operations, when other operations in the 
ribbon may become temporarily irrelevant. An example is the Work Plane modal 
tab. When working with work planes, other tabs are not shown, since they do not 
present relevant operations.

THE RIBBON VS. THE MODEL BUILDER

The ribbon gives quick access to available commands and complements the model 
tree in the Model Builder window. Most of the functionality accessed from the 
ribbon is also accessible from contextual menus by right-clicking nodes in the 
model tree. Certain operations are only available from the ribbon, such as selecting 
which desktop window to display. In the COMSOL Desktop interface for macOS 
and Linux®, this functionality is available from toolbars, which replace the ribbon 
on these platforms. There are also operations that are only available from the 
model tree, such as reordering and disabling nodes.
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THE QUICK ACCESS TOOLBAR

The Quick Access Toolbar contains a set of commands that are independent of the 
ribbon tab that is currently displayed. You can customize the Quick Access Toolbar 
and add most commands available in the File menu, including commands for 
undoing and redoing recent actions, as well as for copying, pasting, duplicating, 
and deleting nodes in the model tree. You can also choose to position the Quick 
Access Toolbar above or below the ribbon.

THE GRAPHICS MENUS

As an alternative to using the model tree or the ribbon, you can right-click in the 
Graphics window to access context-dependent menus. The menus shown will 
depend on which node is currently selected in the model tree. By using the Go To 
option, when available, you can jump to a context menu for another node in the 
model tree.

MACOS AND LINUX®

In the COMSOL Desktop environment for macOS and Linux®, the ribbon is 
replaced by a set of menus and toolbars.
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The instructions in this book are based on the Windows® version of the COMSOL 
Desktop environment. However, running COMSOL Multiphysics and the 
COMSOL Desktop environment in macOS and Linux® is very similar, keeping in 
mind that the ribbon user interface components can instead be found in the 
corresponding menus and toolbars. In addition, the Application Builder is only 
available in the Windows® version. However, you can run apps in all supported 
operating systems.

The Model Builder and the Model Tree

Using the Model Builder, you build a model by starting with the default model 
tree, adding nodes, and editing the node settings.
All of the nodes in the default model tree are top-level parent nodes. You can 
right-click them to see a list of child nodes, or subnodes, that you can add beneath 
them. This is the means by which nodes are added to the tree.
When you click a child node, you will see its node settings in the Settings window. 
It is here that you can edit node settings.
It is worth noting that if you have the Help window open, which is achieved either 
by selecting Help from the File menu or by pressing the function key F1, then you 
will also get dynamic help (in English only) when you click a node.

THE ROOT, GLOBAL DEFINITIONS, AND RESULTS NODES

A model tree always has a root node 
(initially labeled Untitled.mph), a 
Global Definitions node, and a Results 
node. The label on the root node is 
the name of the multiphysics model 
file, or MPH file, to which the model 
is saved. The root node has settings 
for author name, default unit system, 
and more.
The Global Definitions node has a Parameters and a Materials subnode by default. 
The Global Definitions node is where you can, among other things, define 
parameters, variables, functions, and couplings that can be used throughout the 
model tree. They can be used, for example, to define the values and functional 
dependencies of material properties, forces, geometry, and other relevant features. 
The Global Definitions node itself has no settings, but its child nodes have plenty 
of them. The Materials subnode stores material properties that can be referenced 
in the Component nodes of a model.
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The Results node is where you access the solution after performing a simulation 
and where you find tools for processing the data. The Results node initially has five 
subnodes:
• Datasets, which contains a list of solutions you can 

work with.
• Derived Values, which defines values to be derived 

from the solution using a number of 
postprocessing tools.

• Tables, which is a convenient destination for the 
Derived Values or for Results generated by probes 
that monitor the solution in real-time while the 
simulation is running.

• Export, which defines numerical data, images, and animations to be exported 
to files.

• Reports, which collects reports about the model in the HTML, Microsoft® 
Word, and Microsoft® PowerPoint formats.

To these five default subnodes, you may also add more Plot Group subnodes that 
define graphs to be displayed in the Graphics window or in Plot windows. Some of 
these may be created automatically, depending on the type of simulations you are 
performing, but you may include additional figures by right-clicking the Results 
node and choosing from the list of plot types. In addition, you can add an 
Evaluation Group node, which is similar to the Derived Values node but with tightly 
associated Evaluation Group tables, and a Parameters node for parameters used 
exclusively in Results.

THE COMPONENT AND STUDY NODES

In addition to the three nodes just described, there are 
two additional top-level node types: Component nodes 
and Study nodes. These are usually created by the Model 
Wizard when you start a new model. After using the 
Model Wizard to specify what type of physics you are 
modeling and what type of Study (for example, 
steady-state, time-dependent, frequency-domain, or eigenfrequency analysis) you 
will carry out, the Model Wizard automatically creates one node of each type and 
shows you their contents.
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It is also possible to add 
more Component and Study 
nodes as you develop the 
model. A model can contain 
multiple Component and 
Study nodes and it would be 
confusing if they all had the 
same name. Therefore, 
these types of nodes can be 
renamed to be descriptive of 
their individual purposes.
If a model has multiple 
Component nodes, they can 
be coupled to form a more 
sophisticated sequence of 
simulation steps.
Note that each Study node 
may carry out a different 
type of computation, so 
each one has a separate 
Compute button .
To be more specific, 
suppose that you build a model that simulates a coil assembly that is made up of 
two parts: a coil and a coil housing. You can create two Component nodes: one that 
models the coil and another that models the coil housing. You can then rename 
each of the nodes with the name of the object. Similarly, you can also create two 
Study nodes, the first simulating the stationary or steady-state behavior of the 
assembly, and the second simulating the frequency response. You can rename 
these two nodes to be Stationary and Frequency Domain.
When the model is complete, save it to a file named Coil Assembly.mph. At that 
point, the model tree in the Model Builder looks like the figure below.
In this figure, the root node is named Coil 
Assembly.mph, indicating the file in which 
the model is saved. The Global Definitions 
node and the Results node each have their 
default name. Additionally, there are two 
Component nodes and two Study nodes 
with the names chosen in the previous 
paragraph.

Keyboard Shortcuts
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PARAMETERS, VARIABLES, AND SCOPE

Global Parameters
Global parameters are user-defined constant scalars that are usable throughout the 
model. That is to say, they are “global” in nature. Important uses are:
• Parameterizing geometric dimensions.
• Specifying mesh element sizes.
• Defining parametric sweeps (simulations that are repeated for a variety of 

different values of a parameter such as a frequency or load).

A global parameter expression can contain numbers, global parameters, built-in 
constants, built-in and user-defined functions with global parameter expressions 
as arguments, and unary and binary operators. For a list of available operators, see 
“Appendix C — Language Elements and Reserved Names” on page 239. Because 
these expressions are evaluated before a simulation begins, global parameters 
cannot depend on the time variable, t. Likewise, they cannot depend on spatial 
variables like x, y, or z, nor on the dependent variables for which your equations 
are solving.
It is important to know that the names of parameters are case sensitive.
You define global parameters in the Parameters node in the model tree under 
Global Definitions.
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Note that you can add multiple Parameters nodes and they will be named 
Parameters 1, Parameters 2, etc. In addition, Parameters can be organized into 
several cases and then swept over. For more information, see “Parametric Sweeps” 
on page 169.
The following spread shows an example of a customized desktop with additional 
windows.
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SETTINGS WINDOW

MODEL BUILDER 
WINDOW

MODEL TREE

QUICK ACCESS TOOLBAR
RIBBON
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DYNAMIC HELP — Continuously updated with online access to the 
Knowledge Base and Application Gallery. The Help window enables 
easy browsing with extended search functionality.

PROGRESS BAR WITH CANCEL BUTTON

GRAPHICS WINDOW

INFORMATION WINDOWS

PLOT WINDOW — 
The Plot window is 
used to visualize 
Results quantities, 
probes, and 
convergence plots. 
Several Plot windows 
can be used to show 
multiple results 
simultaneously.
 | 29



Results Parameters
For greater flexibility, it is possible to define parameters that are only used in the 
Results node. Using these parameters does not require resolving the model.

Result parameters may depend on other parameters and built-in functions.

Variables
Variables have associated Variables nodes in the model tree and can be defined 
either in the Global Definitions node or in the Definitions subnode of any Component 
node.

Naturally, the choice of where to define the variable depends on whether you want 
it to be global (that is, usable throughout the model tree) or locally defined within 
a single Component node. Like a parameter expression, a variable expression may 
contain numbers, parameters, built-in constants, and unary and binary operators. 
However, it may also contain variables like t, x, y, or z; functions with variable 
expressions as arguments; and dependent variables that you are solving for, such 
as temperature T or voltage V, in addition to their space and time derivatives.
If you have a model with many Variables nodes it may be useful to group them 
together by using the Node Group feature, as shown below. You access this menu 
by right-clicking the Definitions node.

Node groups can be used to group nodes in Global Definitions, Definitions under a 
Component, Geometry, Materials, physics interfaces, and results.
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Variables Used in Applications
Model parameters and variables can be used in applications. For example, you can 
let the user of an application change the value of a parameter. In addition, variables 
to be used in applications can be defined in the Application Builder, in the 
application tree under the Declarations node. Such variables can also be used in 
model methods.

Scope
The “scope” of a parameter or variable is a statement about where it may be used 
in an expression. All global parameters are defined in the Global Definitions node 
of the model tree as a Parameters subnode. This means that they are global in 
scope and can be used throughout the model tree.
A variable may also be defined in the Global Definitions node, as a Variables 
subnode, and have global scope, but they are subject to other limitations. For 
example, variables may not be used in Geometry, Mesh, or Study nodes (with the 
one exception that a variable may be used in an expression that determines when 
the simulation should stop).
A variable that is instead defined under the Definitions subnode of a Component 
node has local scope and is intended for use in that particular Component (but, 
again, not in the Geometry or Mesh nodes). They may be used, for example, to 
specify material properties in the Materials subnode of a Component or to specify 
boundary conditions or interactions. It is sometimes valuable to limit the scope of 
the variable to only a certain part of the geometry, such as certain boundaries. For 
that purpose, provisions are available in the settings for a variable to select whether 
to apply the definition either to the entire geometry of the Component or only to 
a Domain, Boundary, Edge, or Point.
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The figure below shows the definition of two variables, q_pin and R, for which the 
scope is limited to just two boundaries identified by numbers 15 and 19.

Such a group of numbers is called a Selection and can be named and then 
referenced elsewhere in a model. This can be useful, for example, when defining 
material properties or boundary conditions that will use the variable at certain 
boundaries but not elsewhere. To give a name to the Selection, click the Create 
Selection button ( ) to the right of the Selection list.
Although the variables defined in the Variables node under the Component > 
Definitions subnode are intended to have local scope, they can still be accessed 
outside of the Component node in the model tree by being sufficiently specific 
about their identity. This is done by using a “dot notation”, where the variable 
name is preceded by the name of the Component node in which it is defined and 
the names are joined by a “dot”. In other words, if a variable named foo is defined 
in a Component node named MyModel, then this variable can be accessed outside of 
the Component node by using MyModel.foo. This can be useful, for example, 
when you want to use the variable to make plots in the Results node. Variables 
defined under the Declarations node in the Application Builder are available 
globally in form objects and methods but cannot be used in the Model Builder.
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Built-In Constants,  Variables,  and Functions

COMSOL Multiphysics comes with many built-in constants, variables, and 
functions. They have reserved names that cannot be redefined by the user. If you 
use a reserved name (a name already used by the software) for a user-defined 
variable, parameter, or function, the text you enter will get a yellow squiggly 
underline (indicating a warning) or a red squiggly underline (indicating an error) 
and you will get a tooltip message if you hover over the text string.
Some important examples are:
• Mathematical constants such as pi (3.14...) or the imaginary unit i or j
• Physical constants such as g_const (acceleration of gravity), c_const (speed 

of light), or R_const (universal gas constant)
• The time variable, t
• First- and second-order derivatives of the dependent variables (the solution) 

whose names are derived from the spatial coordinate names and dependent 
variable names (which are user-defined variables)

• Mathematical functions such as cos, sin, exp, log, log10, and sqrt

See “Appendix C — Language Elements and Reserved Names” on page 239 for 
more information.

The Application Libraries

The Application Libraries are collections of MPH files containing tutorial models 
and runnable applications with accompanying documentation. Tutorial models 
show how to use the Model Builder and have documentation that includes 
theoretical background and step-by-step instructions. Runnable applications have 
instructions on how to use the application. You can readily inspect and edit all 
tutorial models and applications to make them your own. Each physics-based 
add-on module comes with its own application library with examples specific to its 
applications and physics area. You can use the step-by-step instructions and the 
MPH files as a template for your own modeling.
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To open the Application Libraries window, select Application Libraries  from the 
Windows menu in the Home toolbar or from the File menu . Then, search by 
application name or browse under a module folder name.

Click Open , Run Application , or Open PDF Document . Alternatively, 
select Help > Documentation from the File menu to search by application name or 
browse by module. Note that the Run Application option is only available for 
MPH files that are runnable applications.
The MPH files in the Application Libraries can have three formats — Solved 
MPH files, Compact MPH files, or Preview MPH files:
• Solved MPH files, including all meshes and solutions. In the Application 

Libraries window, these appear with the  icon. If the MPH file size exceeds 
25 MB, a tooltip with the text Large file and the file size appears when you 
position the cursor at the model’s node in the Application Libraries tree.

• Compact MPH files, with all settings for the model but without built 
meshes and solution data to save space in the installation. Some MPH files 
have no solutions for other reasons such that the computation time is short 
and the results are easily regenerated. You can open these to study the 
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settings and to mesh and re-solve. It is also possible to download the full 
versions — with meshes and solutions — of most of these when you update 
your Application Libraries. These appear in the Application Libraries window 
with the  icon. If you position the cursor at a compact file in the 
Application Libraries window, a No solutions stored message appears. A solved 
version is available for download via the Application Library Update (except 
in a few cases where the file is a template related to another, regular, model).

• Preview MPH files, with only a model description and thumbnail image 
available. These appear in the Application Libraries window with the  icon. 
The file is a preview of an application or a model file, including the model 
description and information about used products and physics interfaces and 
the computation time. Solved and compact versions are available for 
download. Model documentation will be available if you have specified the 
use of online help (see the Reference Manual for details on how to do this).

The Application Libraries are updated on a regular basis by COMSOL. To check 
all available updates, click Update COMSOL Application Libraries  at the top of the 
Application Libraries window. You can also find this option from the File > Help 
menu (Windows® users) or from the Help menu (macOS and Linux® users). This 
connects you to the COMSOL website, where you can access new applications 
and the latest updates.

If your computer has internet connection, then you can click the Application 
Gallery button to access a wide range of additional examples from the COMSOL 
website.
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Workflow and Sequence of Operations

In the Model Builder window, every step of the modeling process, from defining 
global variables to the final report of results, is displayed in the model tree.

From top to bottom, the model tree defines an orderly sequence of operations.
In the following branches of the model tree, the node order makes a difference 
and you can change the sequence of operations by moving the subnodes up or 
down the model tree:
• Geometry
• Materials
• Physics
• Mesh
• Study
• Plot Groups
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Nodes may be reordered by these methods:
• Drag-and-drop
• Right-clicking the node and selecting Move Up or Move Down

• Pressing Ctrl + Up arrow or Ctrl + Down arrow
In other branches, the ordering of nodes is not significant with respect to the 
sequence of operations, but some nodes can be reordered for readability. Child 
nodes to Global Definitions is one such example. You can use the filter text field 
above the model tree to display only those nodes that match the search string you 
enter here. The Filter Options menu, available in the Model Builder toolbar, has 
additional settings for modifying the search results.

You can view the sequence of operations presented in the model tree as program 
code statements by saving the model as a Model File for MATLAB® or as a Model File 
for Java® after having selected Compact History in the File menu. Note that the 
model history keeps a complete record of the changes you make to a model as you 
build it. As such, it includes all of your corrections, including changes to 
parameters and boundary conditions and modifications of solver methods. 
Compacting this history removes all of the overridden changes and leaves a clean 
copy of the most recent form of the model steps. In the Application Builder, you 
can use the Record Method option to view and edit program code statements in the 
Method Editor.
As you work with the COMSOL Desktop interface and the Model Builder, you 
will grow to appreciate the organized and streamlined approach. However, any 
description of a user interface is inadequate until you try it for yourself. In the next 
chapters, you are invited to work through two examples to familiarize yourself 
with the software.
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Example 1: Structural Analysis of a Wrench

This simple example requires none of the add-on products to COMSOL 
Multiphysics®. For more fully featured structural mechanics models, see the 
Structural Mechanics Module application library.
At some point in your life, it is likely that you have tightened a bolt using a wrench. 
This exercise takes you through a structural mechanics model that analyzes this 
basic task from the perspective of the structural integrity of the wrench subjected 
to a worst-case loading.
The wrench is, of course, made from steel, a ductile material. If the applied torque 
is too high, the tool will be permanently deformed due to the steel’s elastoplastic 
behavior when pushed beyond its yield stress level. To analyze whether the wrench 
handle is appropriately dimensioned, you will check if the mechanical stress level 
is within the yield stress limit.
This tutorial gives a quick introduction to the Model Builder workflow. It starts 
with opening the Model Wizard and adding a physics option for solid mechanics. 
Then a geometry is imported and steel is selected as the material. You then explore 
the other key steps in creating a model by defining a parameter and boundary 
condition for the load; selecting geometric entities in the Graphics window; 
defining the Mesh and Study; and finally, examining the results numerically and 
through visualization.
If you prefer to practice with a more advanced model, read this section to 
familiarize yourself with some of the key features, and then go to the tutorial 
“Example 2: The Busbar — A Multiphysics Model” on page 78.
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Model Wizard

1 To start the software, double-click the COMSOL 
Multiphysics icon on the desktop, which will take you to 
the New window with two options for creating a new 
model: Model Wizard or Blank Model.

If you select Blank Model, you can right-click the root node 
in the model tree to manually add a Component and a Study. 
For this tutorial, click the Model Wizard button.
If the COMSOL Desktop user interface is already open, 
you can start the Model Wizard by selecting New from the 
File menu. Choose the Model Wizard.

The Model Wizard will guide you through the first steps of 
setting up a model. The next window lets you select the 
dimension of the modeling space.

2 In the Select Space Dimension window, select 3D.
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3 In Select Physics, select 
Structural Mechanics > Solid 
Mechanics (solid) . Click 
Add.
Even without add-on 
modules, the Solid Mechanics 
interface is available in the 
Structural Mechanics folder. In 
the picture to the right, part 
of the Structural Mechanics 
folder is shown as it appears 
when all add-on modules are 
available.

Click Study  to continue.

4 Click Stationary  under General 
Studies. Click Done  once you 
have finished.
General Studies and other preset 
studies have solver and equation 
settings adapted to the selected 
physics, which is, in this example, 
Solid Mechanics. A Stationary 
study is used in this case — there 
are no time-varying loads or 
material properties.
Any selection from the More Studies branch  requires manual settings.
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Geometry

This tutorial uses a geometry that was previously created and stored in the 
COMSOL native CAD format, .mphbin. To learn how to build your own 
geometry, see “Appendix A — Building a Geometry” on page 214.
The location of the Application Library that contains the file used in this exercise 
varies based on the software installation and operating system. In Windows®, the 
file path will be similar to:
C:\Program Files\COMSOL\COMSOL64\Multiphysics\applications.
Now, import the ready-made geometry file as follows.
1 In the Model Builder window, under Component 1, right-click Geometry 1  and 

select Import .

As an alternative, you can use the ribbon and click Import  from the Geometry 
tab.
 | 41



2 In the Settings window for Import, from the Source list, if not already selected, 
select COMSOL Multiphysics file.

3 Click Browse and locate the file wrench.mphbin in the application library folder 
of the COMSOL installation folder. Its default location in Windows® is
C:\Program Files\COMSOL\COMSOL64\Multiphysics\applications\
COMSOL_Multiphysics\Structural_Mechanics\wrench.mphbin

Double-click to add or click Open.
4 Click Import. The geometry is now displayed in the Graphics window.

In the Import section, there are 
two options for locating a file 
for import: Browse and Browse 
From. The Browse option lets 
you import a file from the file 
system using the Open dialog. 
The Browse From option lets 
you browse from either the file 
system or a Model Manager 
database.
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5 Click the wrench geometry in the Graphics window and then experiment with 
moving it around. As you point to or click the geometry, it changes color. Click 
the Zoom In , Zoom Out , Go to Default View , Zoom Extents , and 
Transparency  buttons in the Graphics window toolbar to see what happens to 
the geometry:
- To rotate, click and drag anywhere in the Graphics window.
- To move, right-click and drag.
- To zoom in and out, click and hold the mouse scroll wheel, and then drag.
- To get back to the original position, click the Go to Default View  button.

Also see “Appendix B — Keyboard and Mouse Shortcuts” on page 231 for 
additional information.
The imported model has two parts, or domains, corresponding to the bolt and the 
wrench. In this exercise, the focus will be on analyzing the stress in the wrench.

Rotate: Click and drag

Pan: Right-click and drag
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Geometry Cleanup

The next step is to define material properties. Before doing so, the geometry must 
be prepared for analysis, which happens automatically when you click a node 
under the Geometry node. This cleanup process removes unnecessary geometric 
details like thin gaps, narrow surfaces, and short edges, which could otherwise 
impede the analysis by requiring an overly fine mesh.
1 Click the Materials node.

The Geometry Cleanup dialog is opened.

The Open Wizard option guides you through each step of the cleanup process, 
but in this example, the automatic option is sufficient.
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2 Click the Clean up Automatically button.
After a few seconds, the Cleanup Log window is shown.

The Cleanup Log window provides information on whether the cleanup was 
successful, the specific actions applied, and other details related to the geometry 
model. The cleanup process added a Remove Details node to the Geometry 
sequence.
In the Remove Details window, you can see which features were removed. In this 
case, 4 vertices were ignored, and 6 face regions were collapsed. These operations 
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improve mesh quality, reducing the number of elements and leading to more 
efficient computations.
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Materials

The Materials node  stores the material properties for all physics and all domains 
in a Component node. Use the same generic steel material for both the bolt and 
tool. Here is how to choose it in the Model Builder.
1 Open the Add Materials window.

You can open the Add Materials 
window in either of these two 
ways:
- Right-click Component 1 > 

Materials  in the Model Builder 
window and select Add Material 
from Library .

- From the ribbon, select the Home tab and then click Add Material.

2 In the Add Material window, click to 
expand the Built-In folder. Scroll down to 
find Structural steel, right-click, and 
select Add to Component 1.

3 Examine the Material Contents section in 
the Settings window for Material to see 
the properties that are available. 
Properties with check marks are used by 
the physics in the simulation. 

4 Close the Add Material window.
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Note that some properties are available as functions of temperature T. If 
you have no heat transfer physics defined in a model, then this temperature 
is taken from the Default Model Inputs under Global Definitions.
See the busbar tutorial sections “Materials” on page 92 and “Customizing 
Materials” on page 141 to learn more about working with materials.
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Global Definit ions

You will now define a global parameter specifying the load applied to the wrench.

Parameters
1 In the Model Builder window, under Global Definitions , choose Parameters 

1 .

2 Go to the Settings window for Parameters 1. In the Parameters table, enter these 
settings:
- In the Name column or field, enter F.
- In the Expression column or field, enter 150[N]. The square-bracket notation 

is used to associate a physical unit to a numerical value; in this case, the unit 
of force in Newtons. The Value column is automatically updated based on the 
expression entered once you leave the field or press Return.

- In the Description column or 
field, enter Applied force.

If you have a Parameters table with more than one entry, you can sort the 
table with respect to a particular column by clicking the corresponding 
header.

The sections “Global Definitions” on page 84 and “Parameters, Functions, 
Variables, and Couplings” on page 136 show you more about working with 
parameters.
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So far, you have added the physics and 
study, imported a geometry, added the 
material, and defined one parameter. The 
Model Builder node sequence should now 
match the figure to the right. The default 
feature nodes under Solid Mechanics are 
indicated by a D in the upper-left corner of 
the node icon .
The default nodes for Solid Mechanics are: 
Linear Elastic Material, Free, and Initial 
Values.
The node Linear Elastic Material is the 
default material model for the Solid 
Mechanics interface. The node Free is a 
boundary condition that allows all 
boundaries to move freely without a 
constraint or load. The node Initial Values 
is used for specifying initial displacement 
and velocity values for a nonlinear or 
transient analysis (not applicable in this 
case).
The default physics nodes cannot be removed. Instead, you specify physics settings 
that deviate from that of the default nodes by adding additional nodes. These 
additional nodes can override or contribute to the settings of the default nodes as 
well as other nodes. For more information, see “Override and Contribution: 
Exclusive and Contributing Nodes” on page 153.
At any time, you can save your model and then open it later in exactly the state in 
which it was saved.
3 From the File menu, select Save As. Browse to a folder where you have write 

permissions and save the file as wrench.mph.
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Physics and Boundary Conditions

With the geometry and materials defined, you are now ready to set the boundary 
conditions.
1 In the Model Builder window, 

right-click Solid Mechanics 
(solid)  and select Fixed 
Constraint .
This boundary condition 
constrains the displacement of 
each point on a boundary 
surface to be zero in all 
directions.

You can also use the ribbon 
and, from the Physics tab, 
select Boundaries > Fixed 
Constraint.

2 In the Graphics window, rotate the 
geometry by clicking anywhere in the 
window and then dragging the wrench into 
the position shown. Click the exposed front 
surface of the partially modeled bolt. The 
boundary turns blue, indicating that it has 
been selected. The Boundary number in the 
Selection list should be 35.

3 Click the Go to Default View button  in the Graphics window to restore the 
geometry to the default view.
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4 In the Model Builder window, right-click Solid Mechanics (solid)  and select 
Boundary Load. A Boundary Load node  is added to the Model Builder sequence.

The “warning” attribute displayed on the Boundary Load node indicates that its 
boundary selection is empty. The next step will be to select a boundary.

5 In the Graphics window, click the Zoom 
Box button  and then click and drag 
the mouse to select the square region 
shown in the figure to the right. 
Release the mouse button to zoom in 
on the selected region.

6 Select the top socket face (boundary 
109) by clicking the boundary to 
highlight it in blue and add it to the 
Selection list.

7 In the Settings window for Boundary 
Load, under Force, select Total force as 
the Load type and enter -F in the text 
field for the z component. The negative 
sign indicates the negative z direction 
(downward). With these settings, the 
load of 150 N will be distributed 
uniformly across the selected surface.
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Note that to simplify the modeling process, the mechanical contact between the 
bolt and the wrench is approximated with a material interface boundary condition. 
Such an internal boundary condition is automatically defined and guarantees 
continuity in normal stress and displacement across a material interface. A more 
detailed analysis including mechanical contact can be done with the Structural 
Mechanics Module.

ADDING A PARAMETER DIRECTLY FROM A TEXT FIELD

As an alternative to the method shown above, you can add or edit a parameter 
directly from a text field. For example, in the case of the wrench model, first type 
the value of the Total force in the text field for the z component. Then, right-click 
the text field and select Create Parameter from the dropdown menu to open a 
Create Parameter dialog, as shown in the second figure below.

In this dialog, you can enter a parameter Name and Description.
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The parameter is now added to the list of Parameters, as shown below.

To edit a parameter, select the parameter in an edit field, right-click, and choose 
Edit Parameter.

Note that when you hover over edit fields and table cells, a tooltip shows the value 
of the parameter or expression. This only works when the value is a constant.
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As an alternative to editing parameters, you can also use the Data Viewer window, 
which can be opened from the Windows menu in the Home tab.

This window remains open in the COMSOL Desktop until you choose to close it.

SELECTING BOUNDARIES AND OTHER GEOMETRIC ENTITIES

When a boundary is unselected, its color is typically gray. The exception is when 
you use the material Appearance setting available in Materials; see page 96. To 
select a boundary, first hover over it. This highlights the boundary in red, 
assuming the boundary was previously unselected. Now, click to select the 
boundary by using the left mouse button. The boundary now turns blue. Its 
boundary number will appear in the Selection list in the Settings window of the 
corresponding boundary condition. Once a boundary is selected and you hover 
over it again, the boundary turns green. If you click a boundary highlighted in 
green, the boundary is deselected and now turns gray again. The same technique 
for selecting and deselecting is applicable to geometry objects, domains, 
boundaries, edges, and points.
The figure below shows the different selection states for a boundary.

To select internal surfaces that are hidden behind the one closest to you, use one 
of the following methods to cycle through the boundaries at the mouse pointer: 
roll the mouse scroll wheel, use the keyboard + and - buttons, use the keyboard 
arrow-up and arrow-down buttons, or use two-finger drag on a touchpad.

Highlighted for selection Selected Highlighted for deselection
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When hovering over a boundary, information about the boundary number and 
surface normal direction is displayed in the upper-left corner of the Graphics 
window, as shown in the figure below.

Similarly, when selecting domains, edges, and vertices the corresponding 
geometric entity number is displayed.
For each boundary surface, the normal vector has a “positive” and “negative” 
direction, referred to as the up and down direction, respectively. When hovering 
over a surface, the information display shows which normal direction is currently 
pointing toward you. This information can be useful, for example, when defining 
more advanced boundary conditions, especially on material interfaces.

SELECTING USING THE GRAPHICS WINDOW CONTEXT MENUS

As an alternative selection method, you can right-click in the Graphics window and 
choose one of the options for domain, boundary, edge, or point selection.
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For example, to assign a Boundary Load boundary condition, first right-click and 
select New Boundary Selection, as shown in the figure below.

Click to select the boundaries to which you would like to apply the boundary 
condition. (In this case, the top socket face; boundary 109.) Then, right-click 
again and select Boundary Load, as shown in the figure below.

You can also use this method to add additional boundaries to the selections of an 
already created boundary condition. In the example above, you could, for 
example, while having the Fixed Constraint node selected, select the menu option 
Add to Boundary Selection for Fixed Constraint 1 (although it wouldn’t be applicable 
in this example).
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SELECTING USING CLIP PLANES

For selecting geometric entities inside complicated CAD models, you can use clip 
planes, clip boxes, clip spheres, or clip cylinders. You select these from the graphics 
toolbar by clicking the Clipping toolbar button.

By selecting a Clip Plane, for example, you can quickly hide all parts of a model that 
is on one side of the plane. The figure below shows a clip plane used to select one 
of the interior boundaries of the wrench model.
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Mesh

The mesh settings determine the resolution of the finite element mesh used to 
discretize the model. The finite element method divides the model into small 
elements of geometrically simple shapes, in this case tetrahedra. In each 
tetrahedron, a set of polynomial functions is used to approximate the structural 
displacement field — how much the object deforms in each of the three 
coordinate directions. The strains are computed by differentiating the 
displacement field. Then, the stresses are computed from the strains using the 
material properties.
In this example, a coarser mesh is sufficient to capture the variations in the stress 
field and provide reasonably accurate results. Refining the mesh to improve 
computational accuracy usually comes at the cost of slower performance and 
higher memory usage.
1 In the Model Builder, under Component 1, click Mesh 1 . In the Settings window 

for Mesh, under Mesh Settings, select Coarser from the Element size list.

2 Click the Build All button  in the Settings window or in the Mesh toolbar.
With the resulting mesh, the model will require about 6 GB of RAM to solve. 
If you have a computer with less memory than that you can select Extra coarse 
or Extremely coarse from the Element size list (instead of Coarser.)
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3 After a few seconds, the mesh is displayed in the Graphics window. Rotate the 
wrench to take a look at the element size distribution (this may vary a bit 
depending on the version you are running).
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Study

In the beginning of setting up the model, you selected a Stationary study, which 
implies that a stationary solver will be used. For this to be applicable, the 
assumption is that the load, deformation, and stress do not vary in time. To start 
the solver:
1 Right-click Study 1  and select 

Compute  (or press F8).
After a few seconds of 
computation time, the default plot 
is displayed in the Graphics 
window. During computation, a 
Progress window shows progress information from the solvers. After the 
computation you can find other useful information about the computation in the 
Messages and Log windows; Click the Messages and Log tabs under the Graphics 
window to see the kind of information available to you. The Messages window can 
also be opened from the Windows dropdown menu in the Home tab of the ribbon.
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Results

The von Mises stress is displayed in the Graphics window in a default Volume plot 
with the displacement visualized using a Deformation subnode. Change the default 
unit (N/m2) to the more suitable MPa as shown in the following steps.
1 In the Model Builder, expand the Results > Stress 

(solid)  node, then click Volume 1 .

2 In the Settings window under 
Expression, from the Unit list, select 
MPa (or type MPa in the field).
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3 Click the Plot button  in the Settings window for the Volume plot and then 
click the Go to Default View button  in the Graphics window.
The von Mises stress distribution is shown in the bolt and wrench under an 
applied vertical load.

You can add additional predefined plots by selecting from the list defined by 
Results Templates under Results or by clicking the corresponding button from 
the ribbon Home tab.
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4 You can, for example, visualize the applied load distribution. Right-click Results 
and select Results Templates. In the Results Templates window, select Solid 
Mechanics > Applied Loads > Boundary Loads and click Add Result Template.

The resulting plot shows the boundary load using arrows.

For our purposes we are not interested in the stress in the bolt. We can selectively 
visualize the stress in just the wrench by adding a Selection node.
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1 Right-click the Stress > Volume 1 node and select Selection .

2 In the Graphics window, click the wrench, domain 1.
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3 Click Plot to see the visualization.

For a typical steel used for tools like a wrench, the yield stress is about 600 MPa, 
which means that we are getting somewhat close to plastic deformation for our 
150 N load (which corresponds to about 34 pounds force). You may also be 
interested in a safety margin of, say, a factor of three. To quickly assess which parts 
of the wrench are at risk of plastic deformation, you can plot an inequality 
expression such as solid.misesGp>200[MPa]. (The suffix Gp indicates that the stress 
variables are obtained from the so called finite element Gauss points.)
1 Right-click the Results node  and add a 3D Plot Group .
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2 Right-click the 3D Plot Group 3 node  and select Volume .

3 In the Settings window for Volume, click 
the Replace Expression button  and 
select Model > Component 1 > Solid 
Mechanics > Stress > solid.misesGp - von 
Mises stress - N/m2 by double-clicking. 
When you know the variable name 
beforehand, you can also directly enter 
solid.misesGp in the Expression field. 
Now edit this expression to: 
solid.misesGp>200[MPa].
This is a Boolean expression that evaluates to either 1 for true or 0 for false. In 
areas where the expression evaluates to 1, the safety margin is exceeded.

4 Change the Color table to RainbowLight and click the Plot button .
5 In the Model Builder window, click 3D Plot Group 3. Press F2 and, in the Rename 

3D Plot Group dialog, enter Safety Margin. Click OK. Alternatively, edit the label 
at the top of the Settings window.

Note that it is sometimes quicker to right-click a Plot Group, select 
Duplicate from the menu, and then make the necessary changes to the 
plot settings.

The resulting plot shows that the stress in the bolt is high, but the focus of this 
exercise is on the wrench. If you wish to comfortably certify the wrench for a 
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150 N load with a factor-of-three safety margin, you would need to change the 
handle design somewhat, such as by making it wider.

You may have noticed that the manufacturer, for various reasons, has chosen an 
asymmetric design for the wrench. Because of that, the stress field may be different 
if the wrench is flipped around. Try now, on your own, to apply the same force in 
the other direction and visualize the maximum von Mises stress to see if there is 
any difference.
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Convergence Analysis

The results from a simulation software such as COMSOL Multiphysics can 
shorten design times dramatically by, for example, reducing the number of 
experiments or product tests. However, simulation software is not a substitute for 
real-world testing. This is especially important if there are risks for physical or 
environmental damage. One way to reduce (but not eliminate) the risk of drawing 
the wrong conclusions from simulation results is to perform a convergence 
analysis.
To check the accuracy of the computed maximum von Mises stress in the wrench, 
you can now continue with a mesh convergence analysis. Do that by using a finer 
mesh and therefore a higher number of degrees of freedom (DOFs).

This section illustrates some more in-depth functionality and the steps 
below could be skipped at a first reading. Note that since the mechanical 
contact between the bolt and the wrench is approximated with a material 
interface boundary condition, there will be stress singularities in this area. 
Due to this, we will neglect the stresses there and focus on the handle. A 
more detailed analysis including mechanical contact can be done with the 
Structural Mechanics Module.

EVALUATING THE MAXIMUM VON MISES STRESS

1 To study the maximum von Mises stress in the wrench, in the Results section of 
the model tree, right-click the Derived Values  node and select Maximum > 
Volume Maximum .

2 In the Settings window for Volume Maximum, under Selection, choose Manual and 
select the wrench, domain 1, by clicking the wrench in the Graphics window. We 
will only consider values in the wrench domain and neglect those in the bolt. In 
addition, since we are only interested in the stress values in the handle, which 
we can achieve by multiplying the stress variable with the expression 
(x>-0.045).

3 In the first row of the Expressions table, in the Expression column, type 
solid.mises*(x>-0.045).
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4 In the Expressions table, type MPa as the Unit.

In addition, to get optimal accuracy, in the same settings window, in the 
Configuration section, change the Point type to Gauss points.

5 In the Settings window for Volume 
Maximum, click Evaluate to evaluate the 
maximum stress. The result will be 
displayed in a Table window and will be 
approximately 368 MPa. The value may 
vary slightly depending on the software 
version and hardware platform.
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6 To see where the maximum value is attained, you can, for example, use a 
Max/Min Volume plot. Right-click the Results node  and add a 3D Plot Group 

. Next, right-click the 3D Plot Group 4 node  and select More Volume Plots 
> Max/Min Volume . Change the name of 3D Plot Group 4 to Max/Min Stress.

7 To plot values in the wrench and not in the bolt, right-click the Max/Min Volume 
 node, select Selection, and then select the wrench, domain number 1.

8 In the Settings window for Max/Min Volume, in the Expression text field, type 
solid.misesGp*(x>-0.045). Alternatively, you can use a Filter node: Right-click 
the Max/Min Volume plot, select Filter, and change the Logical expression for 
inclusion to x>-0.045.

9 In the Settings window under Expression, from the Unit list, select MPa (or enter 
MPa in the field).

10Click the Plot button . This type of plot simultaneously shows the location of 
the maximum and minimum values and also their coordinate location in the 
table below (the exact values may differ depending on the version you are 
running).
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An alternative way of plotting the maximum and minimum stress is to 
right-click the Stress > Volume plot and select Marker.

Note that the maximum and minimum values using this approach can 
differ somewhat since the evaluation method is slightly different.

PARAMETERIZING THE MESH

We will now define a parametric sweep for successively refining the mesh size while 
solving and then finally plot the maximum von Mises stress versus mesh size. First, 
we define the parameters that will be used for controlling the mesh density.
1 In the Model Builder window, click Parameters 1  under Global Definitions .
2 Go to the Settings window for Parameters. In the Parameters table (or under the 

table in the fields), enter these settings:
- In the Name column or field, enter hd. This parameter will be used in the 

parametric sweep to control the element size.
- In the Expression column or field, enter 1.
- In the Description column or field, enter Element size divider.

3 Now, enter another parameter with 
Name h0, Expression 0.01/3, and 
Description Initial element size. 
This parameter will be used to 
define the element size at the 
beginning of the parametric sweep.

4 In the Model Builder window, under 
Component 1, click Mesh 1 . In 
the Settings window for Mesh, select 
User-controlled mesh from the 
Sequence type list.
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5 Under Mesh 1, delete the Size 1 node . This setting controls the boundary 
mesh and to simplify the setup only the volume setting will be used.

6 Under Mesh 1, click the Size node .
7 In the Settings window for Size, under Element 

Size, click the Custom button.
Under Element Size Parameters, enter:
- h0/hd in the Maximum element size field.
- h0/(4*hd) in the Minimum element size field.
- 1.3 in the Maximum element growth rate field.
- 0.1 in the Curvature factor field.
- 0.2 in the Resolution of narrow regions field.
See page 106 for more information on the 
element size parameters.

PARAMETRIC SWEEP AND SOLVER SETTINGS

As a next step, add a parametric sweep for the parameter hd.
1 In the Model Builder window, right-click Study 1  

and select Parametric Sweep . A Parametric 
Sweep node is added to the Model Builder 
sequence.

2 In the Settings window for Parametric Sweep, under the table in the Study 
Settings section, click the Add button . From the Parameter name list in the 
table, select hd.

3 Enter a range of Parameter values to 
sweep for. Click the Range  button 
and enter the values in the Range 
dialog. In the Start field, enter 1. In 
the Step field, enter 1, and in the Stop 
field, enter 4. Click Replace. The 
Parameter value list will now display 
range(1,1,4).
The settings above make sure that as 
the sweep progresses, the value of 
the parameter hd increases and the 
maximum and minimum element sizes decrease.
See page 169 for more information on defining parametric sweeps.
For the highest value of hd, the number of DOFs will exceed three millions. 
Therefore, we will switch to a more memory-efficient iterative solver.
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4 Under Study 1 > Solver 
Configurations > Solution 1, 
expand the Stationary Solver 1 
node , and right-click Suggested 
Iterative Solver  and select 
Enable. Selecting an iterative 
solver option typically reduces 
memory usage but may require 
physics-specific tailoring of the 
solver settings for efficient 
computations.

5 Click the Study 1 node and select 
Compute , either in the Settings window or by right-clicking the node. You can 
also click Compute in the Home or Study ribbon tabs. The computation time will 
be a few minutes (depending on the computer hardware) and memory usage 
will be about 10 GB. If you don’t have this amount of memory on your system, 
you can instead use a parametric sweep from 1 through 3, or even 1 through 2.

RESULTS ANALYSIS

Note that after running the parametric sweep, a new default plot node is created 
corresponding to the new Dataset Study 1/Parametric Solutions 1.

As a final step, analyze the results from the parametric sweep by displaying the 
maximum von Mises stress in a table.
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1 In the Model Builder window, under Results > Derived Values, select the Volume 
Maximum 1 node .
The solutions from the parametric sweep are stored in the Dataset named Study 
1/Parametric Solutions 1. Now, change the Volume Maximum settings 
accordingly:

2 In the Settings window for Volume Maximum, change the Dataset to Study 
1/Parametric Solutions 1.

3 Click the arrow next to the Evaluate button at the top of the Settings window 
for Volume Maximum and select to evaluate in a New Table. This evaluation may 
take a few seconds, depending on the computer.

4 To plot the results in the Table, click the Table Graph  button at the top of the 
Table window (the first few values will vary due to slight mesh variations 
between versions for coarser meshes before a more mesh-converged value has 
been reached).

It is more interesting to plot the maximum value vs. the number of DOFs. This 
is possible by using the built-in variable numberofdofs.

5 Right-click the Derived Values node  and select Global Evaluation .
6 In the Settings window for Global Evaluation, change the Dataset to Study 

1/Parametric Solutions 1.
7 In the Expressions field, enter numberofdofs.

You can type the first few characters of the variable name and then use 
the keyboard shortcut Ctrl+Space to get a variable suggestion from the 
list of available variables.

8 In the Settings window for Global Evaluation, click the arrow next to the Evaluate 
button and select the option to evaluate in Table 2, or Table 1, depending on 
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which previous steps you chose to follow. This displays the DOF values for each 
parameter next to the previously evaluated data.

This mesh-convergence analysis shows that the computed value of the maximum 
von Mises stress in the wrench handle will decrease from the high original value, 
for a mesh with about 250,000 DOFs, to about 369 MPa for a mesh with about 
3,400,000 DOFs. If we further refine the mesh we will find that the results will 
stay approximately around the value 369 MPa.
The figure below shows the associated Table Graph and Table Graph Settings 
window.

Note that depending on the version of COMSOL Multiphysics that you are 
running, the above values may vary slightly due to variations in the number of 
elements generated by the meshing algorithm.
As an alternative to Derived Values, you can use Evaluation Groups. An Evaluation 
Group shares some of the properties of Plot Groups as well as Derived Values. An 
Evaluation Group comes with an integrated table whereas Derived Values outputs to 
a table of your choice. In addition, Evaluation Groups allows you to automatically 
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reevaluate after solving. To enable this, select the corresponding checkbox in the 
Settings window of the Results node as shown in the figure below.

In this Settings window you can also request to regenerate all plots after solving.
You add an Evaluation Group in the same way as a Plot Group: by right-clicking the 
Results node. The figure below shows an Evaluation Group that performs the same 
task as the Derived Values described earlier.

To get optimal accuracy, in the Volume Maximum settings window, in the 
Configuration section, make sure the Point type is set to Gauss points.
The figure below shows the corresponding Evaluation Group table.

This concludes the wrench tutorial.
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Example 2: The Busbar — A Multiphysics Model

Electrical Heating in a Busbar
This tutorial demonstrates the concept of multiphysics modeling in COMSOL 
Multiphysics using the Model Builder. You will learn how to use one of the many 
preconfigured multiphysics combinations as well as subsequently add the effects 
of physics phenomena not initially included in the analysis. At the end, you will 
have built a truly multiphysics model.
The model that you are about to create analyzes a busbar designed to conduct a 
high amount of direct current in an industrial setting (see picture below). The 
current conducted in the busbar, from bolt 1 to bolts 2a and 2b, produces heat 
due to the resistive losses, a phenomenon referred to as Joule heating. The busbar 
is made of copper, while the bolts are made of a titanium alloy. Busbar bolts are 
usually made of steel, but in this example, we will assume a highly corrosive 
environment. Therefore, a titanium alloy was chosen.
Under normal operational conditions, the currents are predominantly conducted 
through the copper. This example, however, illustrates the effects of an unwanted 
electrical loading of the busbar through the bolts. The fact that there are different 
materials is important because titanium has a lower electrical conductivity than 
copper and will be subjected to a higher current density.

The goal of your simulation is to precisely calculate how much the busbar heats 
up. Once you have captured the basic multiphysics phenomena, you will have the 
chance to investigate thermal expansion that generates structural stresses and 
strains in the busbar and the effects of cooling by an air stream.

Titanium Bolt 2b Titanium Bolt 1

Titanium Bolt 2a
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The Joule heating effect is described by conservation laws for electric current and 
energy. Once solved for, the two conservation laws give the temperature and 
electric field, respectively. All surfaces, except the bolt contact surfaces, are cooled 
by natural convection in the air surrounding the busbar. You can assume that the 
exposed parts of the bolt do not contribute to the cooling or heating of the device. 
The electric potential at the upper-right vertical bolt surface is 20 mV and the 
potential at the two horizontal surfaces of the lower bolts is 0 V. This corresponds 
to a relatively high and potentially unsafe loading of this type of busbar. 
More advanced boundary conditions for electromagnetics analysis are available 
with the AC/DC Module, such as the capability to give the total current on a 
boundary. A more advanced model that includes multiple busbars in an assembly, 
as shown in the figure below, can be found in the Application Library, including 
versions for some of the LiveLink™ products for CAD.

Busbar Model Overview
More in-depth and advanced topics included in this tutorial are used to show you 
some of the many options available in COMSOL Multiphysics. The following 
topics are covered:
• “Parameters, Functions, Variables, and Couplings” on page 136, where you 

learn how to define functions and nonlocal couplings.
• “Material Properties and Material Libraries” on page 141 shows you how to 

customize a material and add it to your own material library.
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• “Adding Meshes” on page 143 gives you the opportunity to add and define 
two different meshes and compare them in the Graphics window.

• “Adding Physics” on page 146 explores the multiphysics capabilities by 
adding solid mechanics and laminar flow to the busbar model.

• “Parametric Sweeps” on page 169 shows you how to vary the width of the 
busbar using a parameter and then solve for a range of parameter values. The 
result is a plot of the average temperature as a function of the width.

• “Parallel Computing” on page 181 gives you an overview of how to solve 
on clusters.

• “COMSOL Multiphysics Client–Server” on page 185 gives you an 
introduction to using the COMSOL Multiphysics client–server mode of 
operation.
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Model Wizard

1 To open the software, double-click the COMSOL 
Multiphysics icon on the desktop.

When the software opens, click the Model Wizard button. 
You can also start the Model Wizard at any time by selecting 
New from the File menu. Then, choose Model Wizard.

2 In the Select Space Dimension window, click 3D.

3 In the Select Physics window, expand Heat 
Transfer > Electromagnetic Heating. Then, 
right-click Joule Heating  and select Add 
Physics. Click the Study  button.
You can also double-click the selected physics 
interface or click the Add button to add 
physics.
(Another way to add physics is to open the 
Add Physics window by right-clicking the 
Component node in the Model Builder window 
and selecting Add Physics .)
Note that you may have fewer items in your 
physics list depending on the add-on 
modules installed. The figure on the right is 
shown for the case where all add-on modules 
are installed.
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4 In the Select Study window, click to 
select the Stationary  study type.
Click the Done button.
Choosing a stationary study means 
that we are solving for the 
steady-state temperature of the 
busbar when it has reached thermal 
equilibrium with its surroundings.
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A preconfigured Study has solver and equation settings adapted to the selected 
combination of physics interfaces; in this example, Joule Heating.
Note that you may have fewer study types in your study list depending on the 
installed add-on modules.

A physics interface is a user interface for a specific physics area that 
defines the equations together with settings for mesh generation, 
solvers, visualization, and results. A multiphysics interface is a 
combination of physics interfaces together with multiphysics couplings. 
The Joule Heating multiphysics interface consists of two physics 
interfaces, Electric Currents and Heat Transfer in Solids, together with the 
multiphysics coupling Electromagnetic Heating that appear in the 
Multiphysics branch. This method of mixing physics is very flexible and 
makes it possible to use all the capabilities of the participating 
single-physics interfaces for multiphysics purposes.
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Global Definit ions

To save time, it is recommended that you 
load the geometry from a file. In that case, 
you can skip to “Geometry” on page 88.
On the other hand, if you want to draw the 
geometry yourself, the Global Definitions 
node is where you define the parameters. 
First, complete steps 1 through 3 below to 
define the parameter list for the model. 
Then, follow step 4 and skip to the section 
“Appendix A — Building a Geometry” on 
page 214.
The Global Definitions node  in the Model 
Builder window stores Parameters, Variables, 
and Functions with a global scope. The model 
tree can hold several model components 
simultaneously, and the definitions with a 
global scope are made available for all components. In this particular example, 
there is only one Component node in which the parameters are used. If you wish 
to limit the scope to this single component, you could define, for example, 
Variables and Functions in the Definitions subnode, available directly under the 
corresponding Component node. However, no Parameters can be defined here 
because Parameters that are defined under Global Definitions are always global.
Since you will run a parametric study of the geometry later in this example, define 
the geometry using parameters from the start. In this step, enter parameters for 
the length of the lower part of the busbar, L; the radius of the titanium bolts, 
rad_1; the thickness of the busbar, tbb; and the width of the device, wbb.
You will also add the parameters that control the mesh, mh; a heat transfer 
coefficient for cooling by natural convection, htc; and a value for the voltage 
across the busbar, Vtot.
1 Under Global Definitions , choose Parameters . In the Parameters table, click 

the first row under Name and enter L.
2 Click the first row under Expression and enter the value of L, 9[cm]. You can 

enter the unit inside the square brackets.
3 Continue adding the other parameters: rad_1, tbb, wbb, mh, htc, and Vtot 

according to the Parameters list below. It is a good idea to enter descriptions for 

2 x rad_1

wbb
L

tbb
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variables in case you want to share the model with others and for your own 
future reference.

Click the Save button  in the Quick Access Toolbar and name the model 
busbar.mph or use the corresponding File menu option. Then, go to “Appendix A 
— Building a Geometry” on page 214.
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The Auto Completion and Find Tools

The model tree contains a large number of parameters and variables. To make it 
easier to find them, you can use the auto completion and find tools as described 
below.

AUTO COMPLETION

You can use Ctrl+Space for auto completion of parameter and variable names. For 
example, in the Parameters table, if you click an empty Expression field and then 
press Ctrl+Space, you will get a list of parameters and variables, as shown in the 
figure below.

This functionality is also available for other edit fields in the Model Builder window.
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FIND

To find parameters, variables, as well as other strings in the model tree, you can 
click the Find button in the Quick Access Toolbar or use the keyboard shortcut 
Ctrl+F. This opens the Find and Replace window.

The results of the search are displayed below the Contains and Replace with fields. 
The results in this example are coming from the completed busbar model by 
searching for the string current.
You can double-click any of the rows in this window to open the corresponding 
Settings window.
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Geometry

This section describes how the geometry can be opened from the Application 
Libraries. The physics, study, parameters, and geometry are included with the 
model file you are about to open.
1 Select Application Libraries  from the 

Windows dropdown menu in the Home tab. 
You can also access the Application Libraries 
from the File menu.

2 In the Application Libraries tree 
under COMSOL Multiphysics > 
Multiphysics, select busbar_geom.

To open the file, you can:
- Double-click the name
- Right-click and select an option 

from the menu
- Click one of the buttons under 

the tree

You can select No if prompted to 
save Untitled.mph.
The geometry in this file is 
parameterized. In the next few 
steps, we will experiment with 
different values for the width 
parameter, wbb.
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3 Under Global Definitions , click the 
Parameters node .
In the Settings window for Parameters, 
click in the Expression column for the 
wbb parameter and enter 10[cm] to 
change the value of the busbar width.

4 In the Model Builder window, under 
Component 1 > Geometry 1, click the 
Form Union node  and then the Build 
All button in the Settings window  to 
rerun the geometry sequence. You can also use the ribbon and click Build All 
from the Geometry group in the Home tab.
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5 In the Graphics toolbar, click the Zoom Extents button  to see the wider busbar 
in the Graphics window.

6 Experiment with the geometry in the Graphics window:
- To rotate, click and drag anywhere in the Graphics window.
- To move, right-click and drag.
- To zoom in and out, click and hold the scroll wheel, and then drag.

- To get back to the original position, click the Go to Default View button .

7 Return to the Parameters table and 
change the value of wbb back to 5[cm].

8 In the Model Builder window, click the 
Form Union node  and then click the 
Build All button  to rerun the geometry 
sequence.

9 In the Graphics window, click the Zoom 
Extents button .

wbb = 10cmwbb = 5cm
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10If you built the geometry yourself, you are already using the file busbar.mph, but 
if you opened the file from the Application Libraries window, select Save As from 
the File menu and rename the model busbar.mph.

After creating or importing the geometry, it is time to define the materials.
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Materials

The Materials node  stores the material properties for all physics and geometrical 
domains in a Component node. The busbar is made of copper and the bolts are 
made of a titanium alloy. Both of these materials are available from the Built-In 
material database.
1 In the Model Builder window, right-click Component 1 > Materials  and select 

Add Material from Library . By default, the window will open on the 
right-hand side of the desktop. You can move the window by clicking the 
window title and then dragging it to a new location. While dragging the 
window, you will be presented with several options for docking.

The Materials node will show a red × in the lower-left corner if you try to 
solve without first defining a material, which we will go over in the next 
few steps.

2 In the Add Material window, expand 
the Built-In materials folder and 
locate Copper. Right-click Copper  
and select Add to Component 1. 
Alternatively, you can double-click.
A Copper node is added to the Model 
Builder window.

3 In the Add Material window, scroll to 
Titanium beta-21S in the Built-In 
material folder list. Right-click and 
select Add to Component 1.
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4 In the Model Builder window, collapse the Geometry 1 node  to get an overview 
of the model.

At this stage, the Materials node may display one or more red × symbols 
depending on the active selection. These will disappear in the next few steps.

5 Under the Materials node, click Copper .

6 In the Settings window for Material, examine the Material Contents section.

The Material Contents section has useful information about the material 
property usage of a model. Properties that are both required by the physics and 
available from the material are marked with a check mark . Properties 
required by the physics but missing in the material are marked with a warning 
sign . A property that is available but not used in the model is unmarked.
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The Coefficient of thermal expansion, Young’s modulus, and Poisson’s ratio 
properties in the table above are not used but will be needed later when 
heat-induced stresses and strains are added to the model.

Because the copper material is added first, by default, all parts have copper 
material assigned. In the next step, you will assign titanium properties to the 
bolts, which override the copper material assignment for those parts.

7 In the Model Builder window, click 
Titanium beta-21S .
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8 Select All Domains from the Selection list and then click domain 1 in the list. Now 
remove domain 1 from the selection list.

To remove a domain from the selection list (or any geometric entity, such as 
boundaries, edges, or points), you can use either of these two methods:
- Click domain 1 in the selection list found in the Settings window for Material. 

Then, click the Remove from Selection button  or press Delete on your 
keyboard.

- Alternatively, in the Graphics window, click domain 1 to remove it from the 
selection list.

The domains 2, 3, 4, 5, 6, and 7 are highlighted in blue.
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You can enable and disable material color and texture from the Color 
toolbar button in the Graphics window. To render the copper components 
using a realistic color, select Show Material Color and Texture. This will also 
enable material-true rendering of other materials. Here, you can also 
enable coloring of selections by selecting Show Selection Colors, as well as 
change the color theme used in the Graphics window.

The figures below show the Settings and Graphics windows corresponding 
to a selection where a color (yellow) other than the default has been used. 
There is also a second selection (not shown) with another color (green).
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Note that to see the color while creating a selection, you need to click the Suppress 
Selection Highlight button in the Graphics toolbar. For more information on 
Selections, see page 149.
To further increase the level of realism in material rendering you can enable 
Environment Reflections from the Scene Light menu button in the Graphics toolbar. 
From this menu you can choose an environment such as Indoor, for example. You 
can also enable effects such as Direct Shadows and Floor Shadows.

The corresponding image, known as a skybox image, will be reflected in 
the material, thereby increasing the level of realism. This is particularly 
visible when the material is a metal, as shown in the figure below.

By selecting the Show Skybox option you can display the corresponding 
skybox image used for the environment reflection.
For best results you will need a graphics card that supports OpenGL. See 
also “Graphics and Plot Windows” on page 14. Not all of these 
visualization options will be used in the remainder of this example.
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9 In the Settings window 
for Material, be sure to 
inspect the Material 
Contents section for the 
titanium material. All of 
the properties used by 
the physics should have a 
check mark .

10Close the Add Material window 
either by clicking the icon in the 
upper-right corner or by clicking 
the Add Material toggle button  
in the Materials group of the 
ribbon Home tab.
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Physics and Boundary Conditions

Next, you will inspect the physics domain settings and set the boundary conditions 
for the heat transfer problem and the conduction of the electric current.
In the Model Builder window, examine the default physics nodes of the 
multiphysics interface for Joule Heating. First, collapse the Materials node. Then, 
click the arrows next to the Electric Currents , Heat Transfer in Solids , and 
Multiphysics  nodes to expand them.

The D in the upper-left corner of a node’s icon ( ) means it is a default node.
The equations that are being solved are displayed in the Equation section of the 
Settings windows of the respective physics nodes.
The default equation form, for example, whether it should be a stationary or 
transient equation, is inherited from the study added in the Model Wizard. In this 
case, the study is stationary and the equation form is the stationary version of the 
equation system for Joule heating. For the Joule Heating multiphysics interface, 
the equation system has the temperature and electric potential as dependent 
variables.
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To always display the equations in the Settings windows, click the Show 
More Options button ( ) in the Model Builder and select Equation Sections 
so that a check mark appears next to it.

The Heat Transfer in Solids and Electric Currents 
nodes have the settings for heat conduction 
and current conduction, respectively.
Under the Electric Currents node, the Current 
Conservation node represents the conservation 
of electric current at the domain level and the 
Electric Insulation node contains the default 
boundary condition for Electric Currents.
Under the Heat Transfer in Solids node, the 
domain level Solid node represents the 
conservation of heat and the Thermal Insulation 
node contains the default boundary condition 
for Heat Transfer in Solids. The heat source for 
the Joule heating effect is set in the 
Electromagnetic Heating node under the 
Multiphysics node. The Initial Values node, 
found in both the Electric Currents and Heat Transfer in Solids interfaces, contains 
initial guesses for the nonlinear solver for stationary problems and initial 
conditions for time-dependent problems.
Now, define the boundary conditions.
1 Right-click the Heat Transfer in Solids node . In the second section of the 

context menu — the boundary  section — select Heat Flux.

Boundary section

Section divider

Domain section
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2 In the Settings window for Heat Flux, 
select All boundaries from the Selection 
list.
Assume that the circular bolt boundaries 
are neither heated nor cooled by the 
surroundings.
In the next step, you will remove the 
selection of these boundaries from the 
heat flux selection list, which leaves them 
with the default Thermal Insulation boundary condition for the Heat Transfer in 
Solids interface.

3 Rotate the busbar to view the back. Move the mouse pointer over one of the 
circular titanium bolt surfaces to highlight it in green. Click the bolt surface to 
remove this boundary selection from the Selection list. Repeat this step to 
remove the other two circular bolt surfaces from the selection list. Boundaries 
8, 15, and 43 are removed.

Cross-check: Boundaries 8, 15, and 43 are removed from the 
Selection list.

43

15

8
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4 In the Settings window for Heat Flux, in 
the Heat Flux section, select Convective 
heat flux as the Flux type. Enter htc in 
the Heat transfer coefficient field, h.
This parameter was either entered in 
the Parameter table in “Global 
Definitions” on page 84 or imported 
with the geometry.

More advanced boundary conditions for heat transfer analysis are 
available with the Heat Transfer Module. Examples include the 
capability to give the total deposited power or to set boundary 
conditions for common natural convection scenarios such as for a 
horizontal or vertical wall.

Continue by setting the boundary conditions for the electric current according 
to the following steps:

5 In the Model Builder window, right-click the Electric Currents node . In the 
second section of the context menu — the boundary section — select Electric 
Potential. An Electric Potential  node is added to the model tree.
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6 Move the mouse pointer over the circular face of the single titanium bolt to 
highlight it and then click to add it (boundary 43) to the Selection list.

7 In the Settings window for Electric 
Potential, enter Vtot in the Electric 
potential field.
The last step is to set the surfaces of the 
two remaining bolts to ground.

8 In the Model Builder window, right-click the Electric Currents node . In the 
boundary section of the context menu, select Ground. A Ground node  is 
added to the model tree. The model tree node sequence should now match this 
figure.

The “warning” attribute displayed on the Ground node indicates that its 
boundary selection is empty. The next step will be to select boundaries.

43
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9 In the Graphics window, click one of the remaining bolts to add it to the 
Selection list.

Repeat this step to add the last bolt. Boundaries 8 and 15 are added to the 
selection list for the Ground boundary 
condition.

10In the Graphics window, click the Go 
to Default View button .

More advanced boundary conditions for electromagnetics analysis are 
available with the AC/DC Module, such as the capability to give the total 
current on a boundary.

COMBINING PHYSICS INTERFACES MANUALLY

As an alternative to using the preconfigured Joule Heating multiphysics interface, 
you can manually combine the Electric Currents and Heat Transfer in Solids 
interfaces. For example, you can start by setting up and solving the model for 

Cross-check: Boundaries 8 and 15.

15

8
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